IIMX: Epyoctnpuoki] 'Epsgvova otn Moprokn Bloroyia

Epyacia: Homology Modeling & Docking
Kanynmig: Nikdériaog M. I'hvkdg

@ortitpra: Movpdrtn Zoopia (142)

Ewayoym

YKOTOG TNG TOPOVGAS EPYACiag NTav 1 TPOPAeyn Tng SoUNG HOg TPMTEIVNG, XPNOUOTODVTOG O UATPO Yol TV
TPOPAEYT ot pia oudAoY ™G, UE YVOOTY, Kotayopnuévn oty pdb doury [Homology Modeling], pe yprion tov
npoypappatog Modeler. TIpokeipévov n mpodPreyn va givar duvorn, ypetdletor pior opotdTTo. aAANAOLYI0G TG TAENS
Tov 25-30% kot av pokettar yio Evivpa g TaEng Tov >= 30%.

[IpobmoBeon NTav N Tpwteivy avty va dbétel ko Béong mpdodeong Kdmotov pikpov popiov (m.y. ATP), dote va
axoArovOnoetl docking pe xprion tov AutoDock Vina.

Mépog 1°: Homology Modeling
M£00d01
v Emdoyf TpoTeivig

EmléyOnke pio mpwteivy, g omoiag m doun dev €xer kotoywpnbel oty pdb ko tawtdypova Siobéter Biom
TPOGOECTG Y10 KATO0 Kpopoplakd Tpocdétn. H apyikn oxéyn yio v emAoyn g Tp@Teivng nTav 1 eENg:

1. Emioyn npoteivng yvootig doung and pdb

2. pBlast

3. DUTpapIoHo OTOTEAEGUAT®OV, OOTE Vo emAgyOel pio mpoteiv pe ompocdidopiotn doun CAA TOVTOTNTA
aAdniovyiog ™ TaEng tov 30% Kot ave

H oxéyn otépbnke pe oyetikn amotuyio, kabdg 0dnynoe o avedpeon TPOTEIVOV Pe eEUpeTIKE HeydAn opoldtnTa
(tng TaEng tov 99%), N omoia onpaivel TG daywPloTNKAY EEEMKTIKA 6TO TOAD TPOGPaTO TapeAfov. AkorovdnOnke
evolhaktikn 066¢ (google: proteins with undefined/ unknown structure etc) kot emAéyOnke n €€ng:

optimized ATP-binding protein family B, partial [synthetic construct]

GenBank AAKS08781
GenPept |dentical Proteins  Graphics

*AAKSBET7E.1 optimized ATP-binding protein family B, partial [synthetic construct]
MDY KDDDDKK TNWQKRIYRVRPCVICKVAPRDWRYENRHLRIYNMCK TCFSHNSINYGDDTY Y GHDDR LMY
TDCKEFSHNTYHNLGRLPDEDRHWSASCHHHHHHMGMSGS

v pBLAST

H mopomdve FASTA odiniovyio vropAndnke oe pBLAST kot €ywve avalnmon HOVO Yo TPOTEIVEG TOL £XOVV
Katoyopnuéveg dopés oty pdb.

Hopduetpot:



Standard Protein BLAST

biagin | blasip | blastx | tblagin | thlasix |

Enter Query Sequence

BLASTP programs search protein databases using a protein query. more...

Enter accession number(s), gi(s), or FASTA sequence(s) & Clear Query subrange &

AAKSB3T8.1
L —

P

Or, upload file Emihoyri apxgiou | Asv emAéxBnk...avéva apysio. @

Job Title |
Enter a descriptive title for your BLAST search @

I Align two or more sequences &

Choose Search Set

Hatakaze + ‘ Protein Data Bank proteins(pdb) Y@

o

Amoteréopato:

Sequences producing significant alignments:
Select: All None Selected:0

i1 Alignments o
Description srilgrxe J:;?:! (2:\[93 val;:ue Ident | Accession
[ Chain A, Structural Insights Into The Evolution Of A Non-Bi Protein 124 124 63% 3e-38 81% 2P05 A
[C] Chain A A Novel Adp- And Zinc-binding_Fold From Function-directed In Vitro Evolution 122 122 62% 1e-37 81% 1Uwi A
(] Chain A Structural Insights into the Evelution of a Mon-Biclogical Protein 122 122 65% 1e-37 82% 2ZP09 A
[J Chain A,_A Non-biological Alp Binding Protein With A Tyr-phe Mutation In The Ligand Binding Domain 121 121 65% 3e-37 80% 3DGO A

‘Eywve Myn tov dopdv avtov (PDB Format) kot ovopdotnkov tseql (2P05_A), tseq2 (LUW1_A), tseq3 (2P09_A)
ko tsegd (3DGO_A) avrictoryo.

RCSB PDB  Deposit + Search ~ Visualize ~ Analyze ~ Download ~ Leamn ~ More -

Structure Summary 3D View Annotations Sequence Sequence Similarity Structure Similarity Experiment

j Display Files ~ [OTo L INES RERe
( Biological Assembly 1 €@ ) 1 UW1 Bi Display Files
FASTA Sequence

A Novel ADP- and Zinc-binding fold from function-directed irl

e

PDB Format
PDB Format (gz)

‘ DOI: 10.2210/pdb1UW1/pdb

Classification: DE NOVO PROTEIN

Expression System: Escherichia coli BL21(DES3) PDBY/MMCIF Format

Deposited: 2004-01-28 Released: 2004-03-26 POBx/mmCIF Format (97)

PDBMLXML Format (gz)

Experimental Data Snapshot wwPDB Validation
Method: X-RAY DIFFRACTION Metric Biological Assembly 1
o Resolution: 1.94 A Rfree M—
R-Value Free: 0.228 Clashscore mmm  Structure Factors (CIF)
R-Value Work: 0.200 Ramachandran outliers e Structure Factors (CIF - gz)
Sidechain outliers ﬂ
&2 3D View: Structure | Electron Density | RSRZ outliers NI 7o fc Map (DSNB)
Ligand Interaction by
g : s fo-ic Map (DSNS)
Peccet

v" Modeller



Basic

1. Koaraokevdotke apyeio pe tnv aAiniovyio tng mpwteivng (gseql.ali).

*Pl:gseql

sequence:gsegl:::::::0.00: 0.00

MDYE DD DD TN ERIYEVRPCVICEVAPRDWEVENRHLREIYNMCETCFSHNSINYGDDT Y YGHDDW LMY
TDCKEFSNTYHNLGRLPDEDRHWSASCHHHHHHHGHSGSﬂ

[ Y S L %]

2. Koataokevdaotnkay ta scripts (1,2,3,4,5)

Scriptl Script2

[rom modeller impore *

log.werbome ()
eny = envizon()

$-— Brepare the input files

$-- Bead in the =equence databasme
=db = =equence_db {enw)
?sﬂﬂ:.mﬂ{sﬁq_dab:hau_ﬁ_lﬂ:'pi’n_EE.pi:' , =eq databa=e format='EIR',
chainz_lizt='ALL', minmax db_seq len={30, 4000), clean sequencesz=True)

$-- Wrise the soquence database in binazy form
? =db.write (zoq databaze_file='pdh 55 .bin', seg database_format='SINAEY',
chains_list='3LL")

$-- Now, Tead in the birary databame
E =db.read(=sg database file='tdb 55 bin', =weq databame_formas='SINANE',
chains_list='3LL")

from modeller import *

$-- Comvers the input =eguence/alignment insc
$#  profils formas .
p=f = aln.to_profilel) env = enviren()

aln = alignment {env)
for (pdb, chain) in (('tsegl’, '}, ("t3eg2', 'A
("tzeqd’, 'R

$-— Zcan sequence database to pick up homologow
Tprf.huj_ldisdb, matrix_offset=-850, rr File='s[LIE

. 'tseqs’, "R,

gap_penalties 1d={-500, -50), n_prof iteraticns=l,

heck File—Falze, max aln ewalue=0.01) m = model (env, file=pdb, model segment=('FIRST:'+chain, 'LAST:'+chain))
aln.append model(m, atom files=pdb, align_ccdes=pdb+chain)
#-— Write out the profile in tewxt format aln.malign()

prf.write(file='scriptl.prf', profile format='TEXT')

aln.malign3d()

#-- Comvers the profile back tc aligrment formas aln.compare_structures()

aln = prf.to_aligmment() aln.id table(matrix file='family.mat')
env.dendrogram(matrix file='family.mat', cluster cut=-1.0)
$-— Write cut the aligmment file

aln.write(file='scriptl.ali’, alignment format='EIR')

Script3 Script4

from modeller import * from modeller import *
from modeller.automodel import *

. #from modeller import scap_protein_od
env = environf()

aln = alignment (env) env = environ()
mdl = model{env, file='tsegZ', model segment=('FIRST:L','LAST:L'}) a = automodel {env, alnfile='gssgl-tssge.ali’,
aln.append model (mdl, align codes=' tseq:i' , atom files='tzegZ.pdb') knowns='tseq2', sequence=’gseql’,

assess_methods=(assess.DOFE,
#scap protein_od.Scorer(),
agzess.GA341))

aln.append(file="gsegl.zli', align codes="gsegl')
aln.align2d()
aln.write(file="gsegl-tsegd.ali"', alignment format='FIR") a.starting_model

aln.write (file="gseql-tseqZ.pep', alignment format='FLE') a.ending model = 5
- a.make ()l

1

Script5

Ll'rom modeller import *
from modeller.scripts import complete_pdb

log.verbose () # reguest verbose cutput

env = environ()

env.libs.topology.read (file="5 (LIB) /top_heav.lib') # read topology
env.libs.parameters.read (file="% (LIE) /par.lib') # read parameters

# read model file
mdl = complete_ pdb(env, 'gsegl.B99590002.pdb")

# Lzzeszs with DOPE:

3 = selection(mdl) # 2ll1 atom selection

5.assess_dope (output="ENERGY PROFILE NO REPORT', file='gsegl.profile
T normalize profile=True, smoothing window=13)

3. "Etpe&ov o1 eviodég omd TO TEPUATIKO.



Modeller

ou can find many useful example scripts in the
examplessautomode]l directory.

It iz recommended that you use Python to run

odeller scripts. However, if you don't have Python installed.
ou can type ‘mod?.208" to run them instead.

:»Program Files“Modeller?_28>cd C:UserssZopiosDesktop~BASIC TUTORIAL~basic—exa
ple

sUzserssEopiosDesktop~BASIC
import site’ failed: use —u

ssUserssEopliosDezsktop~BASIC
import site® failed; use —wv

sUzserssEopiosDesktop~BASIC
import site’ failed: use —u

ssUserssEopliosDesktop~BASIC
import site® failed; use —wu

sUzerssEopiosDesktop~BASIC
import site® failed; use —wu

sUserssEopliosDesktop~BASIC

TUTORIAL~bhaszic—example *mod? .20
for traceback

TUTORIAL~bazic—example >mod? .20
for traceback

TUTORIAL~bhaszic—example *mod? .20
for traceback

TUTORIAL~basic—example >mod? .28
for traceback

TUTORIAL~bhaszic—example *mod? .20
for traceback

TUTORIAL-~basic—example >

scriptl . py

script2 _py

scriptd.py

scriptd.py

scripth.py

4. To output amd kabe script nrav to e€ng:

Ano scriptl

HITS FOUND IN ITERATION: 1
Dypamically allocated memory at amaxprofile [B,KiB,MiB]: 704010 687.510 0.671
1 8657 16700 &7 109 83.33 0.0 2 66 7 T2 1 -1
T
»Pl;g=eqgl
sequence::gsedgl: 0: = 0: :::-1.00:-1.00

MDYEDDDDEETNWOERIYRVRPCVICEVAPRDWRVENRHLRIYHMCKTCFSNSINYGDDT Y YGHDODWLMYT DCKE
FSNTYHNLGRLFDEDRHWSASCHHHHHHMGMSGS *

>P1l:luwll
structure:luwlh: 1: 66 1:-1.00:-1.00
——————DDEKITNWLERIYRVRPCVECEVAPRNWEVENEKHLRIYNHMCKTCFWNN S IDIGDDT YHGHDDWLMYAD———

e

|=.\\= Number of sequences: 2
# Length of profile 109
# A 1
# G -500.0 -50.0
# : —-450.0
#F : ${LIB}/blosumé2.=im.mat
1 0 109 1 109 ] 1] i} 1] 0.0
X 1 &7 7 T2 1 1] 66 83 0.0
MDYKDDDDEETHWORRIYRVRPCVICEVAPRDWRVENRHLRIYNMCKT CFSNS INYGDDT Y YGHDDWLMYT DCEEF SNT YHNL.GRLPDEDRHWS ASCHHHHHHMGMS G5

———-—-DDEKTHWLERIYRVRPCVECEVAPRNWEVENKHLRIYNMCKTCFNNS IDIGDDT YHGHDDWLMYAD

Amb 116 4 Tpwteiveg Tov avevpédnkav amd to PBLAST, povo n pio eppavictnie oty mopardve AMoTto Kot ouTh
ypnotpomodnke otn cuvéyelo mg template.

Amd script2



Sequence identity comparison (ID TABLE):

Diagonal ... number of residues;
TUpper triangle ... number of identical residues;
Lower triangle ... % segquence identity, id/min{length}).

tseglAflrseg?hltseq3n@losegen@2

tseqlih@2 63 63 &1 &0
tseq2h@l 100 &7 &5 &4
tseg3RBl a7 a7 69 L1}
tseqih@z 95 kL EE] [3:]

Weighted pair-group average clustering based on a distance matrix:

.——- tseglh@z.s 0.0000
|
. Tseg2REl. 9 3.7500
1
1 e tseq3n@l.6 1.0000
| |
tseg4RR2.5
3.3000 3.2250 2.5500 1.8750 1.2000 0.5250 -0.1500

3.5625 2.8875 2.2125 1.5375 0.8625 0.1875

Daivetor Tog ot tseql ko tseq2 etvon apkeTd Kovtd eEEMKTIKA, EVD KATL Tapdpoto cvupPaivet Kot pe Ti tseq3d Kot
tseg4. Amd tig dvo mpmteg Kakvtepo resolution £xet n tseg2 (1,9 A), evd amd tig GhAeg dvo, 1 tseq3 (1,6 A).

Amd script3

_aln.pos 10 20 30 40 50 &0

tseqgq2 @~ 0 —-——-——- DOEETHNWLERIYRVRPCVECEVAPRNWEVENEHLRIYNMCKT CFNNSIDIGDDT YHGHDDWL

gsegl MOYKDDDDEKTHWOERIYRVRPCVICEVAPRDWRVENRHLRIYNMCETCFSNSINYGDDT Y YGHDDWL
consrvd EREEEA R REERAARRRR RHRRERRRE R R R RRRRRRRRRRRR R RR R R R R R R

_aln.p 70 80 a0 100

tsegl MYRAD: 5

gsegl MYTDCEEFSNIYHNLGRLPDEDRHWSASCHHHHHHAMGMSGS

_consrvd ¥ ¥ *

Amd script4

»>» Summary of successfully produced models:

Filename molpdf DCPE =core GAL341 =core
gseql . B992380001 ., pdb £8.089103 —7376,. 72266 1.00000
gseql.BS8S9990002.pdb 527.86420 -7332.98778 1.00000 I
gzeqgl .BSS990003 . pdlb 668,15710 -7605.58152 1.00000
gseqgl . .B95990004 . pdl 532.02405 -7630.54932 1.00000
gseql .B99980005.pdb 656.57220 —7545.23145 0.99338

Emiéyeton 10 povtého ue 1o younAidtepo molpdf/ DOPE score © pe 1o peyadvtepo GA341 score. Evaiiaktikd
UopoHV va, peretndovv OAa.

B PYMOL Viewer

PyMOL Viewer




Amd script5

-0.01 T T T T T
Madel
-0.015 _/ Template
1

-0.02

-0.025
-0.03 |
-0.035 H
-0.04 ||
-0.045 |
-0.05F |

-0.055 |

-0.06 ' ' L

100 120

To mopamdvo StaypopLLLe TPOEKVYE LLE TNV EVTOAN:

gnuplot> plot 'C:\Program Files\Modeller9.20\bin\test\BASIC TUTORIAL\basic-example\model.profile' using 1:42

title 'Model' with lines, 'C:\Program Files\Modeller9.20\bin\test\BASIC TUTORIAL\basic-example\template.profile'
using 1:42 title Template' with lines

Superposition
Superpose
SuperPose used the sequence alignment to guide
the supersposition
r—Local RMSD
Alpha
Carhons  Back Bone Heavy All
RMSD 0.57 0.56 117 117
Atoms 67 268 546 546
Structure Residues
PDBA 7-73
1UW1 chain 'A’ 7-73
—Global RMSD
Alpha
Carbons  Back Bone Heavy All
RMSD 0.57 0.56 117 117
Atoms 67 268 546 546
Structure Residues
PDBA 7-73
1UW1 chain 'A’ 7-73

Tm align

Superposition of two proteins Superposition of two proteins with ligands and solvents (when available)




TM-align Results

B T LT T T L e e

TM-align (Version 281787@8)
An algorithm for protein structure alignment and comparison
Based on statistics:
8.8 ¢ TM-score < 9.3@, random structural similarity
8.5 < TM-score < 1.88, in sbout the same fold
Reference: Y Zhang and ] Skolnick, Nucl Acids Res 33, 2382-9 (2885)

Please email your comments and suggestions to: zhng@umich.edu
B S Y T T T T T Tl T L T LT T T T T T T LT L L T T b T T T T e T

L T
# O* O * # H

Mame of Chain_1: A487691
Mame of Chain_2: B487691
Length of Chain_1: 189 residues
Length of Chain_2: 67 residues

Aligned length= &7, RMSD=  @.36, Seq_ID=n_identical/n_aligned= 8.836
TM-score= ©.60376 (if normalized by length of Chain_1)
TM-score= @.98617 (if normalized by length of Chain_2)
{(You should use TM-score normalized by length of the reference protein)

{(":" denotes aligned residue pairs of d < 5.8 A, "." denotes other aligned residues)
MDYKDDDDKK TNWQKRIYRVRP CVICKWVAPRDWRYENRHLRIYNMCKTCFSNSINYGDDTY Y GHDDWLMY TDCKEF SNTYHNL GRL PDEDRHWSAS CHHHHHHMGMSGS

Yopmépoopa:

H 6oun mov mpoPrépbnke @épetl 2 a-éhikeg kot 3 B-mTuxTd QOAAM, OTMOC KOl 1) APYIKN TOV YPNCILOTOONKE Yo
pfiTpa. Ao v vrépbeon v Sopdv TpokvTTEL £va oxeTkd xounid RMSD, tdéco arnd to Superpose, 660 Kot omd 1o
Tm align. Eziong, to Tm-score, énwg tpokvmtel amd to Tm align, ivar >0,5. Zvvendg, Qaivetol mmg 1 opotdtta Tmv
doudv dev glvar tuyaia.

Advanced (Multiple Templates)

1. Scripts

Scriptl Script2

1 # Illustrates the SALIGN multiple structurs/sequence slignment from modeller i - ort *

1
3 from modeller import * 2
“ N N 3 log.verboae()
s og_verbose
& env = enviren() 4 env = environ()
B env_io. atom files directory = ' /- /atom files/' 5
8 - . e
: aln = alignmens{env) 6 env.libs.topology.read (file="5
10 Trw (code, chain) in {{'tseql’, '2'), ('tseq?’ e 7
11 mdl = model{env, file=code, model segment= . - .
1z 2ln.zppend_model (mdl, atom files=code, align codes=code+chain # Read aligned structurs(s):
9 aln = alignment (env)
1z 2
14 for (weights, write_fit, whole) im ({(1., 0., 0., 0., 1., 0.}, Falze, True), 10 aln.append{file=' fml12589.a1i" . Bllgﬂ codea="211 I}
1s {(L., 0.5, 1., 1., 1., 0.), False, True), ~ -
15 (1., 1.,1,1,1, 03, True, Falae)) 11 aln_block = len(aln)
17 = aln.salign{rms_cuteff=3.5, nnrma11ze_pp scores=False, 2
18 rr_file='s (LIE , overhang=30,
ac qapjenalmu o = 13 # Read aligned sequence(s):
z0 gap_penalties ! gap gap score=0, gep residue score=0 14 aln.append (file="gseql.ali', align_codes='gseql')
21 dendrogrem £il . 15
22 alignment_type='tree', § If 'progresive', the tree is not o . .
23 # computed and all structues will be & # Structure sensitive variable gap penalty sequence-sequence alignment:
24 £ aligned sequentially to the first 17 aln.salign{output="", max gap length=20,
25 feature weights=weights, # For = multiple sequence zlignment only _ N - -
26 $ the first feature needs to be mon-zero 18 gap_functicn=True, # to use structure-dependent gap penalty
27 improve_slignment=True, fit=True, write_fit=write_ fit, 19 alignment_type=' SE', align_block=aln block,
28 L te_whol hol tput= y o .
i write_whols pds=whole, outpu 20 feature_weights=(l., 0., 0., 0., 0., 0.), ocverhang=0,
30 aln write(file= alignment_format=' 21 gap_penalties ld=(-430, 0),
g nonrive e slignment_formar=' 22 gap_penalties_2d=(0.35, 1.2, 0.9, 1.2, 0.6, 8.4, 1.2, 0., 0.),
23 [laln.salign(rms_cutoff=1.0, nnmlizer zcores=Falaa, 23 similarity flag=True)
34 rr_file='3 (LI t', overhang=30, 24
35 gapjenalbles 1a-(-1 0), gep_penalties 3d=(0, 3), . . . . . . ~
25 scare=0, dendrogrem file='lis3A.tree’, 25 aln.write (file="qgzeq ali', alignment_format='EIR
37 ', feature weights=[01*&, 26 aln.write (file="g3e pap', alignment format='FAE')
38 write fit=True, o -
- 27




Script3 Script4

B Wmea om0 R e

.

from modeller impert * 2 from modeller import =
2 from modeller.scripts import complete_pdb
from modeller.automodel import * E]
a log.verbose () # reguest verbose output
= env = environ ()
env = environ() & env.libs.topelogy.read(file="5 (LIS) /top heav.lib') # read topology
. 7 env. FILIB) /pas.lib') # read paramsters
%a = automodel (env, alnfile='gsegl-mult.ali', El
=("tseqld', "taeq?h’, 'taeq3h', 'taeqad ="qaeql’ = # read model file
knowns=('taeqlA’, 'taeqah’, 'taeqiA’, 'tseqdd]'), sequence='gseql') 10 mdl = complene pdb(env, ‘gseqgl.B99590003.pdbt)
a.starting model = 1 11 n i —
X 12 # R=sess a atoms with DOPE:
a.ending_model = 3 13 = = melection (mdl)
14  [Fls.assess_dope (output="'ENERGY FROFILE NC_REFORT', file='gsegl.profile’,
a.make () s (T normalize_profile=True, smoothing, windowsls)
18

2. Evtolég oto tepuatikd
3. Outputs

Amd Scriptl

_aln.pos 10 20 30 40 a0 a0
taeqli -——-KKTHWLERI ¥REVE PCVHCEVAPRNWEVENKHLR I YNMCKT CFNNS IDIGDDT YHGHDDWLMYA-
taeqih --DDKETHWLERI YEVR PCVECEVAPRNWKVENKHLR I YNMCKT CFNNS IDIGDDT YHGHDDWLMYAD
taeq3h DODDKKTHNWLER I YEVE PCVECEVAFRDWKVENKHLR I YNMCKI CFNNS IDIGDDT YHGHVDWLMYAD
taeqdh DDDDKETHWLERI ¥YREVE PCVHCEVAPRDWEVENKHLR I FNMCKTI CFNMS IDIGDDT YHGHVDWLMYAD

o R s W Rk

CDHEII'Vd FEEIF R IR I I AT A I A I A I D FI A I A A IEE AAFA A I A A A AR A AR A A AT Fhk Ak h A
7
it _aln.pos
g taeglh -
10 taeqglh 3
11 taeql3k 3
12 taegil S
13 _conarvd
14
T
2 seiroseqia
3 structureX:tseql fit.pdb:9 :RA:+63 :A:MOL_ID 1; MOLECULE A NON-BIOLOGICAL ATP BINDING PROTEIN 1819; CHAIN A:; ENGINEERED YES:MOL ID 1: ORGANISM_SCIENTIFIC UNIDENIIFIED; ORGANISM Ti
' ——— NCHTCENNSTDIGDDT

>PL;taeqh

£  structureX:tseq2 fit.pdb:7  :A:+67 :AMOL ID 1; MOLECULE ARTIFICIAL NUCLECTIDE BINDING PROTEIN (ANEP); CHAIN A; FRAGMENT NUCLEOTIDE BINDING DOMAIN; ENGINEERED YES; OTHER DETAILS '
s NWLKRT MCKTCENNSIDIGODT ——-

R Do 5+

1

12 >Plitseqid

13 structureX:tseq3 fit.pdb:5  :A:+§9 :A:MOL ID 1 MOLECULE A NON-BIOLOGICAL ATP BINDING PROTEIN WITH TWO MUT N32D AND DESV: CHATN A; ENGINEERED VES; MUTATION YES:MOL ID 1; ORGANISM
14 - THRLKRT NHCKTCENNSTDIGDDT

[ L — 5%

17 sp1;
18 structureX:tseqd fit.pdb:5  :A:+69 :A:MOL_ID 1; MOLECULE ATP BINDING FROTEIN-DX; CHATN A; ENGINEERED YES; MUTATION YES:MOL_ID 1; CRGANISM SCIENTIFIC UNIDENTIFIED; ORGANTSM_TAXID
18 - 1

22 >Plrgseql
23 sequence:qaeal: i sz 0,005 0,00

24 THWQKRIYRVREC TCKTCRSNSTNYGDDT TDCKE
25  FSNTYHNLGRLPDEDREWSASCHHEHHEMGMSGS*

1 ===================c==============s======================== taeglh 0.2250
2 |

3 | e taeglh 0.1656
4 | |

5 | | .——— taeq3k 0.0638
[ | |

7 e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e taegdl

8

9 +---t+-+t+t+t++-+-—t++——+-—+———

0 0.2314 0.2024 0.1734 0.1444 0.1154 0.0864 0.0574

1 0.2169 0.18749 0.15849 0.123949 0.1009 0.0719

[ e e
I X




Amd Script2

=] o A = Lo k3

o om oo

[
N

]

13

_aln.pos 10 20 30 40 30 (1]

tseglh  -———————- EHINWLERIYRVRPCVECKVAFRNWEVENKHLEI YNMCKT CFNNSIDIGDDT YHGHDDWL

tseg2h @ -——--- DDEETHWLER I YRVR PCVECKVA PRNWEVENEKHLE I YNMCKTCFNN S I DIGDDT YHEHDDWL
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»> Summary of successfully produced models:
Filename molpdf
gseql.B99990001.pdb 2670.26611
|gseql .BS95530002 . pdb 2623.945448 |
gseql.B99990003.pdb 2682.56519
gseql.B99990004.pdb 2713.20508
gseql.B99990005.pdb 2637.54810
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Mépog 2°: Docking
Avotoymg, vanipée TPoPANUa dekrepaimong Tov fUaTog avToD.
‘Eywe gykatdotoon tov autodock vina kot tov autodock tools.

- File > Read molecule. EmiléxOnke 1 doun tng npwteivng, g omoiog 1 dopun mpoPrépbnke amd to Modeler.
- Edit > Hydrogens > Add > Polar only

- Grid > Macromolecule > Protein > Save

- Ligand > Open > Save

74 AutoDockTools = Y
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[pépreyn Oéong [Ipodcdcong Tov ATP

H npoPreym éywve pe ) ypnon tov Tm align.

ATPbind RESULTS PAGE

Protein with unknown
structure

Protein Name:

query_protein

Protein Sequence:

MDYRDDDDEETHNWOFRRIYRVRPCVICEVAPRDWEVENRHLEIYNMCE

V
YYGHDDWLMYTDCREFSNTYHNLGRLPDEDRHWSASCHHHHHHEM

Predicted Binding Pocket(s) (after PocHunter)

Protein Name Binding Pocket ID Ligand Type Binding Sites
query_protein BS01 ATP K10
. - D32 R34 E36 R41 Y43 N44 M4s C46 K47 F50
query_protein BS0Z ATP ~ a
Y61l Y62
Protein Name:
query_protein Template

Protein Sequence:

DDRRTHNWLERIYRVRPCVRCEVAPRNWEVENRHIETYNMCRETCFNNSIDIGDDTYHGHDD

BT WAL T O
WLMYREDS




Predicted Binding Pocket(s) (after PocHunter)

N26 K28 K30 R35 Y37 N38 M39 C40 F44 Y55

T BSO1 ATP
it H56 G57 H58

Adyw amotvyiag tov docking, ypnowomombnke to Tm align, dote va mpoPrepdei n 0éon npdedeong tov ATP
oV vd uehét mpoteivn kot oto template. Ta KOKKIVO KOTAAOWTO GTIG TOPOTAV® EIKOVEG ivol anTd OV
obupova pe to Tm align cvpuetéyovv oty npdodeon tov ATP. Xe kOkkvo mAaiclo onuaivovial avtd mTov
eaivetor va gueaviCouv pio opotdtnto petald tov 000 mpoteivav. o v axpifeia, vrapyel éva potifo
«PRXWYVO», 6mov ot Béon X cvvavtdvton ta apwvo&ikd katdioura D ko N, mov givar kot ta 600 vopopiia.
2t 0éon Y cvvavtdviot Oetikd gopticpéva, vdpdeiha apvosikd katdiouto Kot otig dvo mpmteives, K & R kot
Katt mopouoto ovpPaivel kot ot Béon O. IMapopore, kot To potifpo «LRIYNMCKY givat kowd, evéd vrdpyovy
Kol cuvInpNuéva katdlowra, onwgn F xain Y.



